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1  ORGANIZATION OF THE HW4 MANUALS 
The HW4 manuals are organized in separate books so as to limit the size of the individual documents. A list 
of the HW4 manuals is provided in document E-M-HW4v3-DIR 

 

HW4 Manuals Contents 

HW4 Main Book 

General software description 
Installation, start-up and settings 
Device connection methods 
Functions common to all devices used with HW4 

Device Specific Functions 1 
(separate book for each device type or model) 

Legacy devices (original HygroClip technology): 
 
o HygroLog NT data logger 
o HygroFlex 2, HygroFlex 3 and M3 transmitters 
     (same icon in device tree) 
o HygroLab 2 and HygroLab 3 bench indicators 
o HygroPalm 2 and HygroPalm 3 portable indicators 
o HygroClip DI digital interface 
o HygroClip Alarm programmable logic 
o HygroStat MB 
 
Device Manager (device configuration) and other device 
specific functions 

Probe Adjustment 1 
Humidity and temperature adjustment function common to 
all legacy devices (original HygroClip technology) 

Device Specific Functions 2 
(separate book for each device type or model) 

Devices based on the AirChip 3000 technology: 
 
o HygroClip 2 (HC2) probes 
o HF3 transmitters and thermo-hygrostats 
o HF4 transmitters 
o HF5 transmitters 
o HF6 transmitters 
o HF7 transmitters 
o HF8 transmitters 
o HL20 and HL21 data loggers 
o HP21, HP22 and HP23 hand-held indicators 
o HygroLab C1 table-top indicator 
o LOG-RC Wireless Data Loggers 
o Custom designed OEM products 
 
Device Manager (device configuration) and Data Logging 
functions 

Probe Adjustment 2 
Humidity and temperature adjustment function common to 
all devices based on the AirChip 3000 technology 

Data Recording 
Data recording function common to all devices based on the 
AirChip 3000 technology 

 
Both the HW4 manuals (software) and device specific manuals (hardware) are available from the HW4 CD. 
The manuals can also be downloaded from several of the ROTRONIC web sites. 
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2  OVERVIEW 
This section of the HW4 manual covers only the following HW4 module: 
 

HW4 Functional Modules for the HP23 Usage 

Device Manager o HP23 user configurable settings and functions 

Record Data o Data capture and Data logging by the HP23 

 
o HW4 functions that are not device dependent are covered in the HW4 manual E-M-HW4v3-Main. 

 

2.1   Functions and settings overview 
 
By itself, the HC2 probe (HygroClip 2) used with the HP23 indicator is already a full-fledged measuring 
instrument that can be used as a stand-alone device. The role of the HP23 indicator is to provide power to 
the HC2 probe and to offer additional functionality and features such as: local data display, local keypad for 
accessing most settings and functions, calculation of additional psychrometric parameters, manual data 
capture, automatic data recording, water activity measurement and probe adjustment.   
 
It is important to note that when used together, the HP23 indicator and HC2 probe (HygroClip 2) constitute a 
2-component system. Each system component has its own microprocessor, firmware and functions. Some 
of these functions are unique to each system component. Other functions are found in both components.  
 
The functions and settings of the HP23 indicator and HygroClip 2 probe (HC2) operate together as indicated 
below: 
 

Function / Setting HP23 HC2 Notes 

Device protection X X Individual to the HP23 and HC2 probe 

RS-485 address X X Individual to the HP23 and HC2 probe 

Device Name X X 
User defined description 
The device name of the HC2 probe is not displayed by HW4 and is 
replaced with the HP23 Input Name 

Calculation X X 
Psychrometric calculation 
HP23 setting overrides HC2 probe setting 

Fixed pressure 
value 

X  Barometric pressure used for some psychrometric calculations 

Data refresh rate X  

Refresh interval for the LC display. When set above 1 s, this setting 
causes the HC2 probe not to be powered in between display 
refreshes so as to conserve battery power. 
 
Note: when the HP23 is recording data, the probe is powered as 
required by the log interval, regardless of the display refresh interval. 

Simulator function X X 
Generates fixed humidity and / or temperature value 
When enabled, HP23 settings override the HC2 probe settings 

Unit system X X 
HP23 setting overrides HC2 setting regarding the HP23 
HC2 probe settings still apply at the level of the probe 
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Function / Setting HP23 HC2 Notes 

Out-of-limits value 
alarm 

X X 

HP23 settings are independent from the HC2 probe settings. 
 
The HP23 does not monitor out-of-limit values defined at the level of 
the probe. Out-of-limit values should be defined at the level of the 
HP23.. 

Analog outputs  X 
Parameter and scale 
HC2 probe settings have no effect on the HP23 

Display X  No effect on the HC2 probe 

Automatic RH 
sensor test and 
compensation 

 X 
The sensor status can be read with HW4 but not with the HP23 
display 

Sensor alarm and 
sensor failure mode 

 X 

The HC2 probe can be configured to trigger an alarm when the RH 
sensor test returns a bad result. Independently of the RH sensor 
test, the HC2 probe will trigger an alarm in the event of a major 
failure of either the RH or temperature sensor (shorted or open 
sensor). 
 
Additionally, the HC2 probe can be configured to generate a fixed 
value for humidity and temperature whenever a sensor alarm is 
triggered. 
 
The HP23 will display an alarm when the RH sensor test returns a 
bad result and will also do so for any shorted or open sensor. 
 

Data logging X X 

Data logging by the HP23 can be started or stopped from the HP23 
keypad.  All log settings can be changed from the HP23 keypad. 
 
Data recording by the HC2 probe itself cannot be started or stopped 
with the HP23 keypad 

Data capture X  
Current data can be manually captured from the HP23 keypad to 
one of the 8 data bins (250 values per data bin) 

Aw Measurement X  
The AW Mode can be enabled, disabled and configured from the 
HP23 keypad. 
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2.2   Detecting the HP23 indicator with HW4 
 
Use a USB cable (mini-USB connector on the side of the HP23) to connect the service connector of the 
HP23 indicator to the HW4 PC. Unless already installed, you should install the ROTRONIC USB driver on 
the PC before running HW4. Proceed as indicated in document E-M-HW4v3-Main. 

 
 

 
 
After detection by HW4, the HP23 appears as an icon in 
the left pane of the HW4 main screen. 
 
 
 
 
 
 

 
 
 
 
 
 
Click on the + sign to the left of the HP23 icon to display 
the HP23 Device Manager module, the Record Data 
module as well as two probe icons (one for each of the 
HP23 inputs). 
 
 
 
 
 

 
 
 
 
 
 
 
Click on the + sign to the left of a probe icon to display a 
list of the available functional modules for the probe. 
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3  DEVICE MANAGER 
 
Device Manager is used to configure the HP23. 
 
 

 
 
 
 
To select the Device Manager for the HP23, click on it 
with the left mouse button. HW4 opens the Device 
Manager form. 
 
 
 
 
 
 
 

Device Manager automatically interrogates the HP23 and downloads its current configuration. 
 

 
 
The different sub-forms that are available within the Device Manager form are listed in a tree located on the 
left pane of the form. To select a sub-form, click on it with the left mouse button. 
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3.1   Device Manager Menu Bar 
The Device Manager menu bar is located at the top of the form. 
 

File 
 
The file menu is used to save to the PC, or to retrieve from the PC, the configuration settings of the HP23. 
The settings are saved in an XML file with the extension DAT. Saving the configuration settings to a file is 
useful for several reasons: 
 

- provides a backup when the device configuration has been changed in error 
- provides a means of quickly configuring a replacement device in the exact same manner as the 

original device 
- provides a means of quickly configuring a number of identical devices  

 
Open: opens the device configuration folder specified in HW4 Global Settings - File Locations Tab - and 

displays all available probe and device configuration files (extension DAT). Select the appropriate file and 
click on Open in the explorer form. The contents of the configuration file are loaded to the Device Manager 
form. Review the contents of the Device Manager sub-forms. Click on the Device Manager OK button to 
write the configuration settings to the device or click on the Cancel button to leave the device unchanged. 
 

 
 
 
Save As: saves the current configuration to an XML file with the extension DAT) in the device configuration 

folder specified in HW4 Global Settings - File Locations Tab. If so desired, any directory and any file type 
may be specified. 
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Exit: exits Device Manager 
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Tools 
 
Firmware Update: This tool is used to update the firmware of the HP23 after downloading a new firmware 

file from the ROTRONIC website to your PC. Firmware files are given a name that shows both to which 
device the file applies and the version number of the firmware. All firmware files have the extension HEX. 
The ROTRONIC website will publish firmware updates as required. 
 
The tool opens a form that allows you to specify the folder where the firmware update file is located and to 
select the file. Click on OPEN to start the update process. 
 

 
 
IMPORTANT: the HP23 must be powered during the entire process. Loss of power when the transmitter is 

being updated may have unexpected results and prevent future operation of the HP23.  
 
Generate Protocol: generates a Device Configuration Protocol. This text file is automatically saved in the 

folder specified in HW4 Global Settings - File Locations Tab. If so desired, any directory and any file type 
may be specified. This action is not recorded in the User Event file.  
 

Help: 

 
HW4 Help: Opens HW4 Help 

 
About HW4: Displays the version number and ID number of HW4 
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3.2   Device Information 
 

 
 

RS485 Address: click on the underlined blue link to change the transmitter address to be used in 

conjunction with an RS-485 network (multi-drop). Each network address should be unique and within the 
values of 1 to 64. Note: the default factory RS-485 address is 0. Click on the Device Manager OK button to 
write the new address to the transmitter. 
 
o Write Protection: This function is used to prevent unauthorized access to critical functions such as 

configuration changes, humidity and temperature adjustment, etc  Click on the underlined link next to 
Device Protection. HW4 opens the following form where a password can be entered (maximum 8 
characters): 

 
 
 
 

 
 
 
 
 
 
 
 
 

Click on the Device Manager OK button to write the new protection settings to the HP23. 
 
FORGOT THE PASSWORD? - Power down the HP23. After powering up the HP23, you have about one 
minute to use the default password !resume! (include the exclamation marks). After one minute the default 

password is no longer accepted. 
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3.3   Settings 
 

 
 
Device Name: As far as possible use a unique device name (maximum 12 characters) 

 
Fixed Pressure Val.: enter here the fixed numerical value to be used for barometric pressure when 

calculating the following parameters: Wet bulb temperature, Enthalpy, Specific humidity and Mixing ratio by 
weight. This numerical value should correspond to the typical barometric pressure at your elevation (or in 
your process) and should be consistent with the unit system that is being used.  Note: when one of the 
probe inputs is set for an analog pressure probe, the probe measurements are used instead of the fixed 
pressure value. 
 
Data Refresh Rate: the user can select a time interval for refreshing the data on the LC display. When the 

interval is 10 s or more, the probes are not powered in between display refreshes so as to conserve battery 
power. 

 
Notes: 

 
o When the HP23 is recording data, the probes are powered as required by 

the log interval, regardless of the value of the display refresh interval. 
o The HygroClip 2 probe will not test the RH sensor when the refresh 

interval for the LC display is set above 1 sec. 
 
Battery Type: select standard or rechargeable. Rechargeable enables the HP23 battery charge 

 function. Be sure not to select Rechargeable when using a standard battery. Attempting to recharge a 
 standard battery is dangerous and could damage the HP23. 
 
 Set to PC Date and Time: click on this link to immediately set the clock of the HP23 to the date and 

 time of the PC. Do not use this link when the HP23 is recording data. 
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3.4   Unit System 
 

 
 
 
 Humidity: enter here the letters to be used after the “%” symbol used for relative humidity 

 
 Temperature and other parameters: Left click on the arrow to the right of the text box and select the 

engineering unit. 
 
Click with the mouse on the blue links labeled Metric or English to globally set the unit system for all 
parameters. 
 
Time Format, Date Format, Date Separator: these settings can be changed to match your preferences 

practices 
 
 
Note: For both HW4 and the local HP23 display, the unit system selected for the HP23 overrides the unit 
system selected for the probe.  
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3.5   Input 1 / Input 2 
Type of Probe: any of the HP23 two probe inputs can be set to accept either a digital HygroClip 2 probe or 

an analog probe. Click on the blue link on the top right corner of the form to change the type of probe. 

3.5.1 Digital HygroClip 2 Probe 
 

 
 
Description: enter here a description for the probe input (maximum 12 characters). This text can be 

displayed in the HW4 current Values tab.  
 
Calculation: Left click on the arrow to the right of the text box and select from one of the available 

psychrometric calculations:  
 

 
Notes: 

 
Dew Point: calculates the dew point above and below freezing 
 
Frost Point: calculates the frost point below freezing and the dew 
point above freezing 
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Lo-Alarm, Hi-Alarm, Hysteresis: Alarm conditions can be defined for humidity, temperature and the 

calculated parameter. Values that are below the low alarm value or above the high alarm value will trigger 
an alarm. The value specified for the alarm function hysteresis is used for both the low and the high alarm. 
 

All versions of HW4 show an out-of-limits value alarm by using red characters on the monitor screen. In 
addition, HW4 Professional can be configured (HW4 global settings - Alarm settings tab) to display an alarm 
table and generate a report whenever an out-of-limits condition occurs. 
 
Note: in general, enable this alarm function only at the level of the HP23 and not at the level of the probe 
 
Generate Humidity Fixed Value / Generate Temperature Fixed Value: place a check mark in these boxes 

to make the HP23 generate fixed humidity and temperature values instead of reporting the actual 
measurements. 
 
The fixed values must be within the following limits: -999.99 and 9999.99 
 
Whenever the humidity and/or temperature signal is set to a fixed value, this is reported on the HW4 main 
screen (current Values tab) as shown below. In addition, an entry is made in the Alarm Table (HW4 
Professional) 
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Simulator Action table 

 

HP23 simulation Probe simulation HW4 and local HP23 display 

enabled enabled or disabled HP23 simulated values 

disabled enabled Probe simulated values 

disabled disabled Actual measurement values 

 

 
 Generate fixed values when probe connection is lost: place a check mark in this box to make the HP23 

generate fixed humidity and temperature values whenever communication with the probe is lost. The fixed 
values are the same as specified under Generate Humidity Fixed Value / Generate Temperature Fixed 
Value. 
 
 
HygroClip 2 Probe Alarms – Action Table 

 
HW4 and the HP23 monitor the alarms generated at the level of the HygroClip 2 probe as indicated in the 
table below: 
 

HC2 probe alarm HW4 HP23 

Out-of-limit value Not  monitored Not  monitored 

RH sensor test 
result = Bad 

- Warning appears on monitor screen 
- Entry in alarm table 
- When the probe sensor failure mode is 
  enabled,  the parameter corresponding 
  to the faulty sensor takes fixed value as 
  per the HC2 probe settings 

- Sensor Alarm appears at the bottom of 
  local display 
- When probe sensor failure mode is 
  enabled, the parameter corresponding 
  to the faulty sensor takes fixed value 
  as per the HC2 probe settings. 

Major sensor 
failure (shorted or 
open sensor) 

- Warning appears on monitor screen 
- Entry in alarm table 
- When the probe sensor failure mode is 
  enabled, the parameter corresponding 
  to the faulty sensor takes a fixed value 
  as per the HC2 probe settings.  

- Sensor Alarm appears at the bottom of 
  local display 
- When the probe sensor failure mode is 
  enabled, the parameter corresponding 
  to the faulty sensor takes a fixed value 
  as per the HC2 probe settings. 
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3.5.2 Analog probe and analog pressure probe (single channel) 
 
Note: Do not forget to configure HW4 to display analog input signals (HW4 Main Menu Bar > Settings and 

Tools > Column Headers > Analog Input). Do not use this setting when the HP23 is in the Aw Mode 
 

 
 
Description: enter here a description for the probe input (maximum 12 characters). This text can be 

displayed in the HW4 current Values tab.  
 
Voltage range: enter here the minimum and maximum of the probe output signal range. The HP23 accepts 

probes with a voltage signal within the limits of 0 to 3.3 VDC 
 
Measuring  range: enter here the minimum and maximum of the probe measuring range. The values must 

be with the following limits: -999.99 and 9999.99 
 
Unit of Measurement: enter here the unit of measurement that will be displayed by both HW4 and by the 
HP23 (maximum 3 characters). When the pressure probe option is selected, HW4 automatically enters in 

this field, the barometric pressure unit selected in the Units System form.  
 
Lo-Alarm, Hi-Alarm, Hysteresis: Alarm conditions can be defined for the parameter measured by the 

probe. Values that are below the low alarm value or above the high alarm value will trigger an alarm. The 
value specified for the alarm function hysteresis is used for both the low and the high alarm. 
 

All versions of HW4 show an out-of-limits value alarm by using red characters on the monitor screen. In 
addition, HW4 Professional can be configured (HW4 global settings - Alarm settings tab) to display an alarm 
table and generate a report whenever an out-of-limits condition occurs. 
 
Generate Fixed Value: place a check mark in this box to make the HP23 generate a fixed value instead of 

reporting the actual measurement. 
 
The fixed value must be within the following limits: -999.99 and 9999.99 
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Whenever the humidity and/or temperature signal is set to a fixed value, this is reported on the HW4 main 
screen (current Values tab) as shown below. In addition, an entry is made in the Alarm Table (HW4 
Professional) 
 
Generate fixed values when probe connection is lost: place a check mark in this box to make the HP23 

generate a fixed value whenever communication with the probe is lost. The fixed value is the same as 
specified under Generate Fixed Value. 

 
Pressure Probe: select this option when the analog probe measures barometric pressure. When this option 

is selected, the pressure measured by the probe is used as an input for a number of psychrometric 
calculations that may be performed on the other probe input.  

3.6   Display 
 

 
 
Load Language File: click on this link to change the language of the HP23 internal menu by writing to the 

HP23 the contents of a language file present on your PC  
 
Backlight Operation: click on the arrow to the right of the box and select from Always off, Always on or On 

Key Press (this last choice applies only to instruments that have the optional display with backlighting) 
 
Display Mode: select from the following options: RH + T + Date / Time,  RH + T + Calculation or large 

display characters (RH or T or Calculation selected on the HP23 with the ENTER key) and date / time 
 
Resolution: select from the following options one or two decimals 

 
Contrast: use the slider to adjust the contrast of the LC display and click on the Update link to change the 

contrast. Click on the Update link to write the new contrast setting to the HP23.  
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Trend Indicator Stability: enter in this text field the stability criteria used by the trend indicators. A value of 

0.01 means that when the rate of signal change is less than 0.01 units per minute, the signal is shown as 
stable. 
 
Show Trend Indicator: check this box to enable the trend indicators on the optional local display. Trend 

indication within the HW4 Current Values tab is a Global Setting of HW4 (HW4 Main Menu > Settings and 
Tools > View tab) 
 
Allow Menu Access: put a check mark in this box to prevent access to the internal menu of the HP23 from 

the keypad. 
 
Enable DPbe/UCalc: check this box to enable the HP23 to display the difference between the two probe 

inputs (measured and calculated parameters : probe 1 less probe 2). Displaying the difference between the 
two probe inputs can be selected from the keypad with the UP or DOWN arrow. When User Calculations is 
enabled, selecting the fictitious third probe displays the user defined calculations and the difference between 
the two probes is no longer available.  

3.7   Aw Mode 
 

 
 
Enable Water Activity Mode: check this box to enable the Aw mode. In this mode, the HP23 automatically 

displays humidity as aw (1.00 aw = 100 %RH)  
 
Enable Beeper: when this box is checked, the HP23 gives an acoustic signal during 5 seconds at the end of 

each Aw measurement 
 
Save Results to Data Bin: when this box is checked, the HP23 automatically saves the water activity value, 

the temperature value as well as the date and time at the end of each measurement. Probe 1 is always 
saved to data bin 1 and probe 2 to data bin 2 (up to 250 records per probe). 
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AwQuick Option: this option accelerates the measurement of water activity. With most products the time 

required to measure water activity is reduced to typically 5 minutes. The measurement starts simultaneously 
for both probe inputs and is ended automatically. 
 
Settings: 

 
o Dwell Time (minutes): initial time during which the AwQuick algorithm does not run 
o Temperature Stability ( ˚C/ min): defines the temperature stability requirement during the 

measurement 
 

AwE Option: Conventional water activity measurement, the HP23 waits for full equilibration of the 

measured product. The measurement starts simultaneously for both probe inputs. The HP23 automatically 
detects full equilibrium conditions and ends the measurement at that time. 

 

Settings: 
 

o Humidity Stability (aw / min):  the measurement ends when this requirement is met.  
o Temperature Stability ( ˚C/ min): the measurement carries on as long as this stability 

requirement is not met  
 
 

3.8   User calculations 
 

 
 
The HP23 can perform and display up to two user defined calculations. Click on the box labeled “Enable” to 
turn on this function. A check mark appears. 
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Rules and Syntax 
 
● Description: text with a maximum of 12 characters maximum. This text appears at the bottom of the HP23 

display. 
 
● Formulas: formulas can be made of up to 64 characters and can contain the variables, constants and 

operators defined below as well as up to 10 levels of nested parenthesis. 
 
● Variables: variables are measured or calculated values from input 1 or input 2 
 

o Temperature Input 1 or 2                :TE1, TE2 
o Humidity Input1 or 2:                       :HU1, HU2 
o Calculated Parameter Input 1 or 2  :CA1, CA2 
o Water Activity Input1 or 2              : HQ1, HQ2  (water Activity mode only) 
o Temperature Input 1 or 2                : TQ1, TQ2   (water Activity mode only) 

 
● Operators and operator symbols: 
 

o Addition            : + 
o Subtraction       : - 
o Multiplication    : * 
o Division             : / 

 
Comparisons and conditional branching are not supported. 
 
 
● Examples 
 

o HU1 – HU2: humidity input 1 less humidity input 2 
o (TE1 + TE2) / 2: average temperature input 1 and input 2 
o TE2 - CA2: difference between the temperature and dew point input 2 (assuming DP is calculated)  

 
 
● A prefix (maximum 2 characters) as well as an engineering unit (maximum 4 characters) can be 

associated with each calculation. Both the prefix and engineering unit are shown on the HP23 display. 
 
Notes:  

o In order to enter °C or °F in the unit field, press the ALT key and type 096 (not 248), release the 
ALT key and type C or F. 

o Click on the blue link labeled “Check Formula” to verify the syntax 
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4  DATA RECORDING 
Data Recording is used to configure the data recording functions of the HP23, to start and stop data logging 
by the HP23 and to download the recorded data to the HW4 PC. 
 

 
To select Data Recording, click on it with the left mouse 
button. HW4 opens the Data Recording form. 
 
 
 
 
 
 
 
 
 
 
 

4.1   Data logging – Settings 
 

 
 
This form is used to select the following: 
 

o Recording mode:  

 
Start-Stop: ends the recording when the memory is full 
Loop: when the memory is full, keep recording and dump the oldest data record 

 
o Log interval: 5 seconds to 1 hour 
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o Probe to be recorded: Probe 1, Probe 2 or both 
 
 

Note: when recording two probes simultaneously, the memory of the HP23 is shared equally between the 

two probes meaning that the recording capacity per probe is half of what it would be when just one probe is 
being recorded.  

4.2   Data Logging – Data Download 
This form is used to download to the PC the HP23 log file. The file can be downloaded even when data is 
still being recorded. 
 

 
 
 
Click on the blue link labeled “Start Download” to download the data logged by the HP23 
 

4.3   Adding a calculated parameter to the log file 
HW4 View Data can be used to add a calculated parameter such as dew point to a log file comprised of 
relative humidity and temperature records. The parameter is calculated for each data record based on the 
relative humidity and temperature values. 
 
HW4 View Data can also be used to replace the calculated parameter in a log file with a different one. 
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HW4 View Data opens automatically after reading data from the HP23 indicator. Files that have already 
been downloaded can be opened from the HW4 main menu bar by selecting File > Open. 
To access the “Add / Change calculated parameter” function, click on Tools in the HW4 View Data menu 
bar and select “Add / Change calculated parameter”.  This opens the following form: 

 
 
 
Use the form shown on the left to select one of 
the available calculated parameters. 
 
NOTE: some parameters such as Enthalpy, 
Mixing Ratio etc. require barometric pressure as 
a calculation input. Be sure to enter the correct 
pressure value in the form. 
 
 
 
 
 
 
 
 
 
 
 
 
 

Click on the OK button to add the selected calculated parameter or change the existing calculated 
parameter. 
 

4.4   Data Capture – Rename Data Bins 
The current humidity and temperature data read by a HygroClip 2 probe can be saved in any of 8 data bins, 
each holding up to 250 records each.  
 
This form is used to replace the generic name of the data bins (Bin 1 to Bin 8) with user specified names. 
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After renaming one or several data bins with a user specific name, click on the blue link labeled “Apply”. 
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4.5   Data Capture – Data Bin Contents 
 
This form is used either to download the contents of a data bin to a file on the PC or to erase the contents of 
the data bin. 
 

 
 
o To download the contents of a Data Bin to the PC, click on the blue link labeled “Download”. 
 
o To erase the contents of a Data Bin, click on the blue link labeled “Erase”. 
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5  PROBES 
 
NOTE: we recommend using the same humidity symbol and the same temperature unit (°C or °F) for both 

the probe and HP23. 
 

 

 
 
 
Click on the + sign to the left of a probe icon to display a 
list of the available functional modules for the probe. 
 
 
To select a function module, click on it with the left mouse 
button. 
 
 
 
 
 
 
 
 

 
o The Device Manager module is used to configure the HygroClip 2 probe connected to the HP23 

indicator and is separately described in the HW4 manual E-M-HW4v3-F2-001 

 
o The Record Data module is common to all probes and instruments based on the AirChip 3000 

technology and is separately described in the HW4 manual E-M-HW4v3-DR-001 

 
o The Probe Adjustment module is used calibrate and adjust the probe humidity and temperature signals. 

This module is common to all probes and instruments based on the AirChip 3000 technology and is 
separately described in the HW4 manual E-M-HW4v3-A2-001 

 
o HW4 functions that are not device dependent are covered in the HW4 manual E-M-HW4v3-Main. 

 
 

6  DOCUMENT RELEASES 
 

Release Software Ver. Date Notes 

_10 3.0.0 June 18, 2010 Original release 

_11 3.1.0 Oct.17, 2011 Updated to HW4 v. 3.1.0 

 
 


